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 مقدمه:

ی است که یکی از قدرتمندترین و متداول ترین زبانهای برنامه نویس #Cزبان برنامه نویسی 

دف هگیرد. این کتاب با امروزه در پروژه های مختلف توسعه نرم افزار مورد استفاده قرار می

 عنوانبه توانمیاز این کتاب تدوین شده است.  #Cآموزش کاربردی زبان برنامه نویسی 

در یسی برنامه سازی پیشرفته، و سایر دروس برنامه نو برنامه سازی شیء گرا،س ودرمرجع 

، اساتید موردتوجهمید است این اثر امود. استفاده نهای فناوری اطلاعات و کامپیوتر رشته

ارم دتقاضا  یزخوانندگان عزاز  و علاقه مندان به زبانهای برنامه نویسی قرار /یرد. دانشجویان

در  اینجانببا  m.a.torkamani@gmail.com نقطه نظرات خود را از طریق ایمیل

ب مورد های احتمالی کتاهای بعدی اشکالات یا کاستیمیان بگذارند تا انشالله در ویرایش
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 فصل اول

 ل استودیو آشنایی با ویژوا 

 

 سی شارپ چیست؟ -1-1

 است که توسط و همه منظوره  شیء گرا بالا، سطحیک زبان برنامه نویسی  (#C) سی شارپ

رای توان بمی#C است. از  JAVA و C ++ های خوبمایکروسافت ساخته شده و ترکیبی از قابلیت

ستفاده ها اموبایل و بازیساخت برنامه های تحت ویندوز، تحت وب، وب سرویس ها، برنامه های 

ست، که شامل مجموعه بزرگی از اجزاء از قبل ساخته شده ا NET.از کتابخانه کلاس  #Cکرد. 

 نصب شود.   Framework   .NET ابتدا باید #Cکند. برای اجرای یک برنامه استفاده می

1-2- Visual Studio 

 را ، پروژه ها و فایل هاآن نیم داخلابتو، به محیطی نیاز داریم که #Cبرای نوشتن برنامه های 

. دنیوگمی IDE 1 به این ابزارها  اجرا کنیم و به خطایابی برنامه بپردازیم. امدیریت کنیم، برنامه ر

ست. با نصب ا Visual Studio ، محیط#Cمعروفترین و بهترین ابزار برای نوشتن برنامه های 

Visual Studio  ،.NetFramework   و زبانC# بر روی سیستم شما نصب خواهند شد. 

  :ها عبارتند از IDE ابزارهای رایج در معمولاً

  یا2ویرایشگر کد  

 3ابزارهای خودکارسازی Build  

 خطایاب یا همان Debugger 

 

                                                           
1 Integrated Development Environment 
2 Source Code Editor 
3 Build Automation Tools 



 با رویکرد علمی و کاربردی #Cبرنامه نویسی                                                      18

Visual Studio  یک IDE توان به زبان هایی مثلکه در آن می است C++  وVisual Basic و 

C# .و ... برنامه نوشت  Visual Studio از نسخه است. مادر نسخه های مختلفی ارائه شده 

Enterprise  کنیممیاستفاده.  

  NET Framework. ساختار  -1-3

های  های آماده از پیش نوشته شده است که در تمامی زبانای از کلاسمجموعه NET.کتابخانه 

شکل  بالایدر دهد.یرا نشان م NET.ساختار  1-1شکل . هستندقابل استفاده  NET. مبتنی بر

سید. دات بنوی های خود را مبتنی بروسیله آنها برنامهه زبان هایی قرار دارند که شما می توانید ب

 یش نوشتهپای از کدهای از . این کتابخانه مجموعهدکتابخانه دات نت قرار دار در مرکز این شکل

که   ددار قرار  CLR. بعد از کتابخانه، دبرای شما راحت تر می کن ار سیبرنامه نویشده است که 

 اهای تحت دات نت رو مدیریت برنامه هااجرای برنامه ، کدهای شما به زبان ماشین وظیفه تبدیل

ریت حافظه به کد ماشین، کنترل و مدیریت اجرای برنامه ها، مدی  ILتبدیل کدهای  .دداربر عده 

 هست. CLR مدیریت امنیت در برنامه های دات نت از وظایفو کنترل و 

و  CLR که وظیفه ارتباط با این لایه، به عهده ددر پایین ترین لایه، سرویس های ویندوز قرار دار

 است قابلیت استفاده مجددبا  جموعه ای از کدهایم کتابخانه دات نت  .کتابخانه دات نت هست

در  که  ستا CLS 1، 1-1دومین مولقه در شکل که در اختیار برنامه نویسان قرار گرفته اند. 

استانداردی هست که با رعایت این استاندارد، کلیه زبان های برنامه نویسی مبتنی  CLSحقیقت 

دو  #C و VB.NET بر دات نت، قابلیت ارتباط با یکدیگر را خواهند داشت. برای مثال زبان های

این قابلیت  CLS نوشته اید، با #C بان مبتنی بر دات نت هستند. زمانی که شما کدی را با زبانز

نیز استفاده  VB.NET در زبان #C نید از کد نوشته شده در زباناکه بتو ودشبه شما داده می

 IL نامتطابق داشته باشند، بعد از کامپایل به یک کد میانی به  CLS کدهایی که با استاندارد .کنید

 IL هست. بعد از ایجاد کد  Assembly کدی شبیه به کد IL کد .شوندترجمه میMSIL 3یا  2

  CLIدیگر  مولفه   شود.به کد ماشین ترجمه شده و اجرا می CLR  توسط IL توسط کامپایلر، کد

                                                           
1 Common Language Specification 
2 Intermediate Language 

3 Microsoft Intermediate Language 
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هست. این استاندارد یک سری خصوصیات مشترک در بین کدهای میانی ایجاد شده توسط     1

به آنها نیاز است. برای مثال سیستم نوع داده  IL کند که برای اجرای کدتعریف می راکامپایلرها 

 آنو اجرای مدیریت شده کدها از خصوصیات   Type Safety یا سرویس های از قبیل 2مشترک

 هستند. 

 
 NET.: ساختار 1-1شکل 

  محیط کاری ویژوال استودیو -1-4

ارپ را ش. برنامه ویژوال سی محیط کاری ویژوال استودیو مورد بررسی قرار میگیرددر این بخش 

 .است 1-2مطابق شکل محیط کار ویژوال استودیو  .اجرا کنید

 (Menu Bar) منو بار-1-4-1

 Menu Bar  شامل منوهای مختلفی برای ساخت، توسعه، نگهداری، ( 1-2در شکل  1)قسمت

خطایابی و اجرای برنامه ها است.با کلیک بر روی هر منو دیگر منوهای وابسته به آن ظاهر می 

دارای آیتم های مختلفی است که فقط در شرایط خاصی  منو شوند.به این نکته توجه کنید که 

                                                           
1 Common Language Infrastructre   
2 Common Type System 
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در صورتی نشان داده خواهند شد که   Projectبه عنوان مثال آیتم های منوی  شوند.ظاهر می

 .های منوها آمده استبرخی از ویژگی 1-1جدول پروژه فعال باشد. در 

 

 
 محیط کار ویژوال استودیو : 1-2شکل 

 

 های منوهابرخی از ویژگی:  1-1جدول 

 توضیح منو 

File  می باشد  شامل دستوراتی برای ساخت پروژه یا فایل، باز کردن و ذخیره پروژه ها و خروج از آنها 

Edit   اشد بشامل دستوراتی جهت ویرایش از قبیل کپی کردن، جایگزینی و پیدا کردن یک مورد خاص می 

View  به شما اجازه می دهد تا پنجره های بیشتری باز کرده و یا به آیتم های toolbar افه کنیدآیتمی اض.  

Project  شامل دستوراتی در مورد پروژه ای است که شما بر روی آن کار می کنید.  

Debug   به شما اجازه کامپایل ، اشکال زدایی و اجرای برنامه را می دهد 

Data  شامل دستوراتی برای اتصال به دیتابیس ها می باشد.  

Format   مرتب کردن اجزای گرافیکی در محیط گرافیکی برنامه می باشدشامل دستوراتی جهت.  

Tools   باشد می استودیو ویژوال و شارپ سی ویژوال برای…شامل ابزارهای مختلف، تنظیمات و.  

Window  به شما اجازه تنظیمات ظاهری پنجره ها را می دهد.  

Help   شامل اطلاعاتی در مورد برنامه ویژوال استودیو می باشد 
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1-4-2- The Toolbars 

 Toolbar  ل مان دستوراتی است که در داخبه طور معمول شامل ه( 1-2در شکل  2)قسمت

دارای   Toolbarکند. هر دکمه در همانند یک میانبر عمل می. Toolbar ها قرار دارندمنو

ها دکمه هرکدام از ایندهد. اگر با نشانگر ماوس بر روی آنرا نشان میکونی است که کاربرد آی

برخی از  شود.مینشان داده  (tool tip) کاربرد آن به صورت یک پیام ، مکث کوتاهی کنید 

توانید با کلیک راست همچنین می شوند.دستورات مخفی هستند و تحت شرایط خاص ظاهر می

 دستورات بیشتری به آن  View > Toolbarsو یا از مسیر   Toolbarبر روی منطقه خالی از 

گر های کوچکی هستند که با کلیک بر روی آنها دیها دارای فلشاضافه کنید. برخی از دکمه

ا ربه شما اجازه جابجایی آن  Toolbarسمت چپ هر . شونددستورات وابسته به آنها ظاهر می

 .می دهد

 (Start Page) صفحه آغازین-1-4-3 

Start   ستفاده می ابرای ایجاد یک پروژه و باز کردن آن از این قسمت  ( 1-2در شکل  3)قسمت

  Recent Projectsتوانید آن را در شود.همچنین اگر از قبل پروژه ای ایجاد کرده اید می

از تعداد زیادی پنجره و منو تشکیل  Visual Studio Community مشاهده و اجرا کنید. 

 هر کدام برای انجام کار خاصی به کار می روند.شده است که 

  ایجاد پروژه جدید-1-5

 پنجره ای .(1-3)شکل یک پنجره فرم ایجاد کنید  File > New Project طریق منویاز  ابتدا

ست گزینه انشان داده شده  1-5همانطور که در شکل  .نمایش داده خواهد شد 1-4به شکل 

Windows Forms     Application   و یک اسم برای پروژه انتخاب می کنیم و بر روی

 .شود ظاهر 1-6شکل کلیک می کنیم تا   OKدکمه 

 : بارت است ازع 1-6نشان داده شده در شکل فرم  هایبخش

  (Design) صفحه طراحی -1 

این صفحه در حکم یک ناحیه برای طراحی فرم های ویندوزی شما است. فرم های ویندوزی 

رابطهای گرافیکی بین کاربر و کامپیوتر هستند و محیط ویندوز نمونه بارزی از یک رابط گرافیکی 
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 به.…است. شما در این صفحه می توانید کنترلهایی مانند دکمه ها ، برچسب ها و  GUI یا 

  .کنید فهاضا فرمتان

 (Solution Explorer) مرورگر پروژه-2

برنامه ای که توسط  Solutionدهد. یک های مربوط به آن را نشان میپروژه و فایل 1-7شکل 

شما ساخته شده است را نشان می دهد.ممکن است این برنامه یک پروژه ساده یا یک پروژه چند 

در صفحه شما نمایش داده نمی شود می توانید از مسیر  Solution Explorerبخشی باشد. اگر 

View > Other Windows > Solution Explorer  و یا با کلیدهای میانبرCtrl+Alt+L 

 (Bold) آنرا نمایان کنید. اگر چندین پروژه در حال اجرا هستند پروژه ای که با خط برجسته

رنامه اجرا می شود. اگر بخواهید پروژه ای را نشان داده شده پروژه فعال می باشد و هنگام اجرای ب

 Setکلیک راست کنید و سپس گزینه Solution Explorerکه فعال نیست اجرا کنید، بر روی 

as StartUp Project را انتخاب نمایید.Solution Explorer زیر یک Solution  پروژه  2با

 .به خود است را نشان می دهد. هر پروژه شامل فایلها و فولدرهای مربوط

 (Properties) پنجره خواص-3

خواص و رویدادهای مختلف هر آیتم انتخاب شده اعم از فرم ، فایل ، پروژه  Properties پنجره 

 View > Otherو کنترل را نشان می دهد. اگر این پنجره مخفی است می توانید از مسیر 

Windows > Properties Window  یا کلید میانبرF4 یک فرم یا اگر .هر کنید.آنرا ظا

انتخاب کنید  SolutionExplorer   کنترل را در صفحه طراحی و یا یک پروژه یا فایل را در 

. این پنجره همچنین دارای (1-8)شکل پنجره خواص مربوط به آنها نمایش داده خواهد شد

اتفاقی است که  (event) رویدادهای مربوط به فرم یا کنترل انتخاب شده می باشد. یک رویداد

کلیک و یا متنی را در  (button) در شرایط خاصی پیش می آید مانند وقتی که بر روی دکمه

نشان  A که با حرف  1-8شکل   combo box اصلاح می کنیم.  (text box) داخل جعبه متن

 خواهید می که را(…داده شده است به شما اجازه می دهد که شی مورد نظرتان )دکمه، فرم و

 بسیار فرم روی کنترلهای که است مفید زمانی کار این. کنید انتخاب دهید تغییر آنرا اصخو

دکمه های ،  combo box زیر در. باشد سخت آنها انتخاب و بوده نزدیک هم به یا کوچک

برخی از این دکمه ها در شرایط خاصی فعال می شوند.دکمه اول خاصیت (B) .مفیدی قرار دارند

اشیا را بر اساس دسته های مختلفی مرتب می کند. دومین دکمه خواص را بر اساس حروف الفبا 
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مرتب می کند که پیشنهاد می کنیم از این دکمه برای دسترسی سریع به خاصیت مورد نظرتان 

تی ظاهر می شود که یک کنترل یا یک فرم را در محیط استفاده کنید. سومین دکمه هم وق

طراحی انتخاب کنیم. این دکمه به شما اجازه دسترسی به خواص فرم ویا کنترل انتخاب شده را 

می دهد. چهارمین دکمه )که به شکل یک رعد و برق نمایش داده شده( رویدادهای فرم ویا 

توضیحات کوتاهی در مورد خاصیت ها و  1-8 کنترل انتخاب شده را می دهد. در پایین شکل

شامل خواص و رویدادها است.در (C) رویداد ها نشان داده می شود. بخش اصلی پنجره خواص

ستون سمت چپ نام رویداد یا خاصیت و در ستون سمت راست مقدار آنها آمده است. در پایین 

و رویدادها در آن قرار دارد که توضیحاتی درباره خواص  (D) پنجره خواص جعبه توضیحات

 .نمایش داده می شود

 تغییر ظاهر ویژوال استودیو -1-6

وانید به ترا دوست نداشته باشید، می  استودیواگر موقعیت پنجره ها و یا ظاهر برنامه ویژوال 

نرا می آکلیک کرده و  (title bar) دلخواه آن را تغییر دهید. برای این کار بر روی نوار عنوان

 .به حالت شناور در آید  1-9کشید تا پنجره به شکل 

هار چکشید یک راهنما )فلشی با در حالی که هنوز بر روی پنجره کلیک کرده اید و آن را می

ان مثال جهت( ظاهر می شود و شما را در قرار دادن پنجره در محل دلخواه کمک می کند. به عنو

ره قرار را در بالاترین قسمت محیط برنامه قرار دهید.منطقه ای که پنجشما می توانید پنجره 

 (.1-10)شکل است در آنجا قرار بگیرد به رنگ آبی در می آید

 (.1-11)شکل  منطقه ای که پنجره قرار است در آنجا قرار بگیرد به رنگ آبی در می آید

شکل حاوی جعبه های پنجره در قسمت بالای محیط قرار داده شده است. راهنمای صلیب 

ال سی مختلفی است که به شما اجازه می دهد پنجره انتخاب شده را در محل دلخواه محیط ویژو

ن قسمت را انتخاب کنید و آنرا به چپ تری Propertiesشارپ قرار دهید. به عنوان مثال پنجره 

ر مذکور د صلیب در پنجره نمایش داده شده نزدیک و رها کنید، مشاهده می کنید که پنجره

 (.1-12)شکلقرار می گیرد Design Viewسمت چپ پنجره 

بالا  کشیدن پنجره به مرکز صلیب راهنما باعث ترکیب آن با پنجره مقصد می شود که در مثال

 (.1-13)شکلدست پیدا کنید Propertiesشما به توانید به عنوان یک تب به پنجره 
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 ایجاد پروژه جدید : 1-3شکل 

 

 
 New Ptojectپنجره : 1-5شکل 
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 : 1-6شکل 

 

 
 های مربوط به آنپروژه و فایل : 1-7شکل 
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پنجره خواص : 1-8شکل   

 
بکشید، یک صلیب  Solution Explorerرا روی پنجره  Propertiesاگربه عنوان مثال پنجره 

راهنمای دیگر نشان داده می شود. با کشیدن پنجره به قسمت پایینی صلیب پنجره 

Properties  زیر پنجرهSolution Explorer (1-14)شکلقرار خواهد گرفت. 

ال ید. ویژوقسمتی از محیط برنامه که می خواهید پنجره در آنجا قرار بگیرد به رنگ آبی در می آ

است که به صورت اتوماتیک پنجره ها  autohideسی شارپ همچنین دارای خصوصیتی به نام 

 close دکمه  دارای یک آیکون سنجاق مانند نزدیکرا مخفی می کند. هر پنجره 

. برای فعال شود auto-hideبر روی این آیکون کلیک کنید تا ویژگی  .(1-15)شکلاست

کنار  دسترسی به هر یک از پنجره ها می توان با ماوس بر روی آنها توقف یا بر روی تب های

 .(1-16)شکلمحیط ویژوال سی شارپ کلیک کرد
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 : 1-9شکل 

 

 
 : 1-10شکل 
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 : 1-11شکل 

 

 
 : 1-12شکل 
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 : 1-13شکل 

 

 
 : 1-14شکل 
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اره ده و دوببرای غیر فعال کردن این ویژگی در هر کدام از پنجره ها کافیست پنجره را انتخاب کر

 .(1-17)شکل بر روی آیکون مورد نظر کلیک کنید

گر شکل به این نکته توجه کنید که اگر شکل آیکون افقی بود بدین معناست که ویژگی فعال و ا

 است.  auto-hideآن عمودی بود به معنای غیر فعال بود ویژگی 

 

 
 : 1-15شکل 

 

 
 : 1-16شکل 


